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Hardware used
= Sinar P 4x5 view camera
= Provia *Fuiji film
= Lighting sources: lighting box
= G4 dual-processor 533 MHz
= 1.5 GB of RAM
= Gretagmacbeth Eye-one spectrophotometer

Software used
= Photoshop CS

In order to illustrate this studio, | chose an image of beauty
products which clearly showed the different problems one
regularly confronts when retouching studio shots. These were
some of Yves Rocher’'s Aroma cosmetic line. The advertising
agency, Lowe Alice, is very demanding when it comes to the
quality of the images. It demands esthetics and meticulousness.
The products that are photographed must be readable and
identifiable straight away. In order to meet that objective, the
agency called on one of the most famous still life
photographers, Christian Cournut.

My work then consisted of making this image more read-
able by removing the typography on the back of the products,
which were transparent, and in harmonizing the reflections on
the bottles.
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It is necessary to work on the |eg| b| | |ty of the image without
betraying the products themselves.
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PHOTO RETOUCHING WITH PHOTOSHOP

Move vigi [4[6
white Mﬁv_‘wj

TM L‘Ml(j vawd
mw.fﬁ {M& n /
w(ew{;m/[ wﬂw'{:(k
' / AA & manve

candle

-

Remove {;:”Wﬂ VWF l’/t‘j v
ek of the bethles

.
Al w(&”‘ ad Aw their
Ve:{:f,%ﬁvwi

the

Cr%vte move IZLM—-

monivd V(f;f[(% ](,‘7 S

AdA

[n//w{/vﬁvw
5 (2% ﬂw

wﬂ%ﬁvw.

K@mv&/ (2




Stage.

The shot

If the finality of the work presented here was the retouching of
the image, it was essential to take a closer look at

the shot itself. In this kind of retouching it is
very important to know what you are look-
ing for, right from the beginning: the
fewer manipulations on the original
photograph, the better

the quality of the final

image.
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\

08 — Aroma

s

Lv’ﬂv# [ty

The products were set on a very clean mirror in order to have
beautiful reflections. They were lit thanks to two sources of
light, called light boxes. These are boxes that are closed by a
Plexiglass plate, inside of which several large flashes are placed.
They provide a diffuse and homogeneous light.

The largest box was placed behind the products so as to give
a nice, white support and transparency to the bottles.

A second box was placed in front of the products, to light them.
However, the latter was slightly off to the side to add contrast.

R(&ﬂ-% {,'VV

View camerva

Then, by using several white card boards of various sizes, the
light was reflected on areas that were a little too dark, or to
create slight gradations. On the other hand, black card boards
would stop the light. This technique enabled us to direct the
light in a very precise way and create beautiful reflections in
the liquids. =

The etymology of (“ tO PhOtogr’aph ”means:

to write with light . . .
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Stage.

The RG4E ﬁ[@ i lig hier thas
the CMYE- ﬁlre, ﬂwwfow

Preparing the ground

It is always best to set a work scheme
right from the beginning. It is very im-
portant to think about the way you
wants to reach your goal in order to
avoid doing things unnecessarily. Very
often, when the retouching work is
finished, the customer, or the agency,
require modifications—and that is
why it is necessary to plan the differ-
ent steps of the project.

Here, for example, | indicated that
| wanted a white gradation in the re-
flection. My choice might not corre-
spond to that of the agency: it might
prefer a lighter, or denser gradation.
That is why | put that reflection on an
individual copy so as to regulate its in-
tensity later on.

st endier tr ol

| decided to work in RGB and to con-
vert everything to CMYK at the end
of the work. That way, if the photo-
engraver decided to do the conversion
herself, in order to adapt it to her
printing machines, | would be able to
give her an RGB file without having to
start all over again.

The toreen weedt to lte ve-cali lprated
qwite often, [teconse its valnes
| Cﬂtﬁij’e wﬁﬂt time.
As J:M ai | am concerned, | Ao
that ench weel.

First of all, | calibrated my screen to make sure my colors were
all right. 1 used the Gretagmacbeth Eye-one to do that. It is very
important to work on a properly calibrated screen, since you
use it in order to adjust colors. Of course, the products in the
photograph must without fail have the same colors as the real
ones.

PR

This is how | was going to proceed: outline all the products and
their reflections, remove the typography on the back of the
products as well as the unwanted reflections and, finally, work
on the white gradation. =



Stage.

Outlining

It is imperative to master outlining well in order to do a good
retouching job. It must be precise and it often takes time. There
are several ways of outlining an image. For the bottles and their
reflections, | picked the Pen tool in order to carry out a precise
selection. This tool works very well with geometrical forms.

The Pen tool is delicate to handle at first, because it is difficult
to learn how to use the directing points and anchoring points

properly.

However, it is worth some perseverance. It is one of the most
precise tools available and often provides very good results.
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The Magic Wand tool, for the type of out-
lining we are dealing with here, gives a
“staircase-like” selection. It lacks preci-
sion and does not provide quality results.
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Once | finished, all | had to do was transform it into
a selection. In the options at the bottom of the paths
palette, | chose Create a Selection from Path. | picked
a 1-pixel radius in order to have a rather clear-cut
selection.

\fu-! Sample Size: [ Point Sample @

e atra e
SERENITE 1.psd @ 50% (Flac 5, Alpha 1)

Make Selection

.

Rendering
Feather Radius: [ 1

™ Anti-aliased

Operation

@ New Selection
Add to Selection
Subt

Intersect w

act from Selection

th Selection

&

| pixels
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|PHOTO RETOUCHING WITH PHOTOSHOP

Creating a Jayer mask

Now | had a selection based on the products. | transformed the
background layer into a normal layer by clicking on it twice. It

S t a g e . is not possible to apply a mask on the background layer. |
named it “Products.” | clicked on the “Add a Mask” icon, at

the bottom of the layers palette. The outlined products ap-

peared.
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Next, | created a j
new layer which | °
filled with white. |37
I named it “Back-
ground” and |
placed it under-
neath the Prod-
ucts layer so as to
give the image a
brighter appear-
ance than with a checked background. This also made it eas-
ier to see potential flaws in the outlining.

| prefer to use a mask rather than eliminate a part of the back-
ground which does not interest me. The mask also enables you
to come back to a selection if need be.

When in Mask mode, it is possible to refine outlines by paint-
ing the areas you wish to hide in black and the parts you wish
to reveal in white. This could not be done if the background
had been erased. m

In this example, it was not necessary to come back to the outlines that often,
because the forms were rather simple to outline with the pen. This is
relatively rare. In the majority of cases, | use the Brush tool to work on the
mask and do spend a lot of time on it. For example, when | deal with

|

transparencies, gradations, blurs, or complicated forms . . .
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— With the lasso, | made a rough selection around the letters,
then | took a sample of their color with the eyedropper tool.
In the Select > Color Range menu, | saved a selection of the

letters that | wanted to keep. By moving the tolerance, |
S I a g | e stopped on the value which not only gave me white letters, but

really black bottles so that in the end, the computer would se-
Protecting ‘[ypography from the rear lect the letters alone. | quickly got a very nice selection.

Seeing the quantity of the characters
that needed to be erased on the back of - =

, _ @ Photwshop || Edn . View _Window K

the first two bottles, | decided to re-do bl |3 [t Tooimesn tow cons

the liquid inside, rather than remove &~

each letter one by one. e Color Range
;‘; Select: «* Sampled Colors m m
.7‘. /‘ Fuzziness: 129 {  Reset
F YEJ!
2.5, _Load...
:; Save..
b | PP
i ‘: Invert
e |
- *]
v

@ selection _ Image

Selection Preview. None @

‘\‘h""'-m._
In a new layer that | named “Inside bot- f oo :Tu:l';l‘i Esm
tles,” I would recreate the color of the ln,,""'
bottle. First, I had to allot a mask to that N, [ f:'w
layer in order to protect the areas | did o) ' ~;':’Ji[Pur.9u.r
not want to touch. All that would be in &
black in the mask would be preserved.

In the Layer menu, | selected Add Layer Mask for the selection. |
proceeded the same way for each letter and each vertical edging.
. b, This would enable me to paint my reflections while preserving the
¢ pime W
It Aoed v ’ typography.
o o the shovb-outs o

the k?&wm/ﬂ It T»V&wwtf

. |
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Protecting the background

ol {;Lw {;;V{Aeﬁf psn The background also had to be protected in order to paint only on
7 wio ahlowis thvw the products. To do that, | recalled the selection of my products
HW YRAARARL again by clicking on the Products layer mask, while pressing the

¢ room Vv ‘b“’@

Lo qain moV lelbes Command key. The product selection appeared on the screen.
Joveen [secante Jome P Then I inverted it (Cmd+Shift+l) in order to keep the background
7 [se chJW'- selection only. Once the Letters layer mask was activated, | selected

black as my background color by pressing the D key. | filled the
selection with that color while pressing Alt+Return. m
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Stage

Recreating the inside of the products

With the Pen tool, |

éi

made a selection of the ot
L
mauve area | had to o7
LA
work on. pos
B
A
| started by painting in A

it

mauve with the brush,
very roughly, in order

]
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Then | took a fairly large brush
(30% opacity, with a 50% flow),
and played with the various
mauves to recreate a liquid with
all the nuances and gradations it
might have.

| did the same with the reflec-
tions. With the bottle on the left
it was even necessary to create
new reflections to make it more
“attractive” and give it more
presence. The photographer had
shown me a version of the pho-
tograph taken under a different
light. It would work better for
this bottle: the reflections were
more harmonious and the large
black flat has disappeared.
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to get rid of the
letters on the back
of the bottles.
With the eyedrop-
per, | made sure to
select exactly the
same mauve color.

wants it to be.
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= Retouching comes in whenever something cannot
be done through a direct shot. Here, the photographer
took a picture in which the light was perfect for four
bottles out of five. When he regulated it to take the
last bottle, the other four did not look as nice. The re-
toucher is able to obtain an image in which the light
on each product is exactly where the photographer

| thus outlined this new bottle and applied it on a new
layer in my image. | used the Displacement tool so that
| could place it precisely over the other layers.

Then | reduced its opacity
t0 50% in order to see the
product that was under-
neath and to position it
exactly where it should
be. With the Transforma-
tion portion of the Move
tool, I gave it a slight ro-
tation (the scans were not
positioned strictly in that
same way).

@ Photoshop File Edit
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@ Photoshop File Edn image Layer Select Fiter View W As in Stage 5, | pro-

B e e 3
& o B B O(O[O[O1N [ | o s st 4__%l el e s @
&S . the back of the bot-

tle and selected each
color.

It is very difficult to preserve both the material the bottles are
made of as well as the appearance of the liquid. Usually,
whether you are touching up a face, a product, a sky, or
anything else, the problem you encounter is preserving the
material. Photoshop is a very powerful tool but it is not
“magic,” unfortunately. It requires know-how and patience.

—

Befmfe

This step was particularly important because | need to recreate
the inside of the first two products. The reflections had to look
real. They had to correspond to the atmosphere the photog-
rapher wanted to instill through the type of light he had cho-
sen. Of course, the same modifications had to be made in the
reflections of each product. =
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Stage

2 [ IR e = - j I started by calling
in the selection
of the candle
(Command-+click
on the candle
layer) to touch it
up and was care-
ful not to go over
the edge of the
background.
With the Clone Stamp tool, | removed the unwanted reflec-
tions and created a more harmonious glass rim.

It is important to make sure that the ( U se a” |a>/e IS
option is activated.

Togivethe immmmms&unmmmm
. S ISR | v ] e W o i iy
candle wick a

fresher look, |

Inserting the candle used the fasso

and selected
Once | had outlined the candle on another photograph, | ap- it. | chose a 5-
plied it on a new layer that | named Candle. | placed it beneath pixel toler-
the Products layer in order to put it behind the cream jar. ance so as to

have a rather
progressive

selection.
Looking at the can- Once | got the
dle, | noticed some right selec-
unsightly reflections. tion, I chose a Luminosity/Contrast adjustment layer: | added

quite a lot of luminosity but little contrast. m
| would touch them
up on a new layer
called Candle reflec-

tions (it was better to . Mw%
do trfis on another A’U”‘rtmewt Lﬂﬂ”{ pre ‘/‘W\‘j‘ L 4
layer to be able to re- lrecanite thffj malce it Twmlat ¢ tv

turn to it, in case |

1
i ne
made a mistake). vebnrn ad Vﬁgw ad wqva to ©

|
vadwes of ench L/‘fj e




Stage
Unsightly reflections

On this image, one can distinguish two kinds of problems: small
“sparkles” and more significant reflections.

| usually use the Clone Stamp at 100% to remove dust and
small “sparkles,” then come back to what | have done with the
same tool but, this time, | used it at 30%, in order to remove
what could still be seen.

Brush: ;’s H Mode: [ Normal @ Opacity | Flow: [100% 8] | ™ Aligned @ Use Al Lay

To correct the most visible reflections—where the cream
jar reflected in the bottle—I selected the part that | had
to work on with the Pen (Line) tool. What interested me
here, was the border between the two color areas, be-
cause | wanted to create a reflection with a progressive
gradation. When one looks at the mauve color in the
center and at the darker mauve color on the right part of
the bottle, the transition between the two is progressive.
It was extremely important to preserve that transition
so that the retouching phase would look as realistic as
possible.
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mode have to lre cme{:w// iy selected.

Once the lining phase
was over, | chose
Load Path as a Selec-
tion at the bottom of
the paths palette.
Within that selection,
and on a new Reflec-
tions bottle 4 layer, |
removed any un-
sightly reflections that
were left from the
clone stamp and the
brush. | masked the
selection (Cmd+H) to
see what | was doing.

-8
.
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e With the polygonal
[ lasso, | selected the
retouching parts that
had been gone over
by moving along the
right side of the bot-
tle. I erased them with
the Return key. m
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The white gradation

| was going to create a gradation which would let the reflec-
tions of the products show progressively. | placed a new layer
named “Gradation” over the Products layer and then picked
white as the foreground color. With the Gradient tool, | se-
lected a linear gradation between the color of the foreground
and the transparency. Finally, | started at the bottom of the im-
age and stopped at the base of the large bottles.

You can see that the gradation went
over the small bottle in the foreground.
[t was thus necessary to create a layer
mask in order to hide that part of the
gradation. The first thing | did was to se-
lect the small bottle with the Pen tool,
which was ideal for a geometrical form 4

like this. /

| trar?sformed the line into a 1-pixel selection (so In the Layer>Add Layer Mask > Hide Selection
that it would be sharp). menu, | again changed it to a mask. That gave the
impression that the gradation had gone behind the
bottle. m
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Stage.,

Final touches and verifications

| went through the entire image once again to check if there
were any flaws that | had to eliminate (such as dust, an out-
line that was not quite perfect, or a layer that had moved). This
was an essential phase since | did not want to send a file with
errors in it to the printer.

Therefore, | looked at each part of the image according to the
real size of the pixels by clicking on the magnifying glass (or by
using the Cmd+Alt+0 short cut on the keyboard).

| started at the top left-
hand corner of the image,
and very meticulously

In a new layer named (‘ Fl nal tOUCheS,” I got rid of

all the small flaws . . .

. [ . . .
scanned it with the Begin- | [Meli(we va{; tﬂu,r Lechwigne Once that was done, | saved my image with all
nina and End arrows. These N its layers on my hard disk. | saved a flattened

y ' it mch wmove vigerond phss version of it (in TIFF format, without compres-
allow you to screen an en- : ’ P
tire image and not miss a udin {;JlMg i’(/vwﬁ{ tvvl/. sion) once | had removed all the lines. That one
single thing g was for the photoengraver. The retouching

In a new layer named “Final touches,” | got rid of all the small
flaws by using the clone stamp. Of course, | placed that layer
over all the others.

| then printed the image in on A4 paper from my photo printer.
This enabled me to spot details | might not have seen other-
wise.

was now entirely done . .. m






